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1. ABOUT BARBOOKS

BarBooks is a multi-device practice management solution created for barristers, by barristers. It takes
care of your general practice and matter management and gives you more time to spend on your work
and family.

Key Features
e Flexible pricing options for readers and barristers
e FEasytolearn and use
e Unlimited users and devices for a single data file
e FEasy to switch from SILQ or other software
e Work on the go
e See how your practice is tracking
e Get the exceptional customer support by phone, email, or live chat

2. START USING BARBOOKS

Understanding the BarBooks interface.
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1. Avatar 7. Expenses 13. Overview
2. Total Unbilled Work & Invoices 8. Reports 14. Task Pane
3. Dashboard 9. Contacts 15. Quick Action
4. Matters 10. Templates 16. Live Chat
5. Invoices 11. Bank Rec 17. Export to CSV
6. Receipts 12. Trend/Graphs




Icon Guide
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Choose a Subscription

BARBOOKS SUBSCRIPTION

BarBooks is a practice g t software for bamisters. It is aimed at making a barmrister's life easier,
and includes functionality for time tracking, matter organising, invoicing, expense recording and tax

compliance

CHOOSE AN OPTION

- Terms and Conditions

ve read and accept the terms & conditions *

PURCHASE SUBSCRIPTION DU RC HASE SU BSC QI pTl O N

Go to this link to subscribe: https://www.barbooksaustralia.com/product/subscription/
Choose an option from the list then click Purchase Subscription.

Enter your billing information and read the terms and conditions.

Click Purchase Subscription.

Hoon -

Importing Data from Another Provider

If you're migrating from a another provider.
1. Attain a copy of your data file.
a. Ifit’s from SILQ, follow these steps.
1. Go to tools (or File tab if you are using the latest version).
2. Then system settings.
3. Select back up.
4. Tick to create a back up in another folder - save somewhere easy to find such as
desktop or documents.
5. Click back up now.
b. Ifit's from another software provider, please contact us directly.
2. Send a copy of your data file to support@barbooks.co with your details.

Schedule a Demo

As part of your onboarding experience, we will arrange a demo for you to see how BarBooks can help
you manage your practice.
1. Please go to this link - https://calendly.com/barbookssupport/45min.
2. Enter the names of those who will be attending the demo with you. (e.g. Jewel Garcia and my
bookkeeper).

3. SETTING UP YOUR ACCOUNT

BarBooks works on any device, be it Mac, Windows or mobile device.

Downloading the app

1. Using your computer: https://www.barbooksaustralia.com/download/




2. Or download the app from your chosen mobile application provider: Google Play Store or App
Store.

£ Download on the

I} Google Play s App Store

Creating a Profile

x
A Ms Jewel Garcia ‘)
4

61 days

subscription left

My Account

@
Preferences e - A

Logout

Click your name or the avatar on the upper right corner of your screen.
Click Avatar to change or upload an image you would like to use.

Click Preferences to set up your account, fill in all fields in the Profile tab.
You may set your time zone preference as well as your role.

Moo~

Please note that these fields are case sensitive and will appear on the invoice exactly how they are
written. If for any reason that your profile details have changed (for example: changing chambers), you
can edit your profile details by selecting Preferences from the drop-down list.

Setting Up Rates

From within Preferences, click the Rates tab.

To add a Rate simply click the Add button.

Type the amount you wish to charge.

Select the charge frequency from the drop-down list.

Moo~



a. Hourly
b. Fixed
c. Units
5. Once complete, simply click the OK button.
6. If you wish to delete a rate, click the X button.
7. If you wish to round up your time, simply choose the amount of time from the drop-down list.

Please note that if you change your rates in Preferences, only future Matters will be affected.

Task Descriptions

X X X X X X 4

From within Preferences, click the Task Description tab.
To add a task description, simply click the Add button.
Type the description in the box.

Once complete, simply click the OK button.

If you wish to delete a task description, click the X button.

o~ wnd =

A task is a piece of work you do for a matter that you wish to bill for or keep a record of in BarBooks.
Please note that these tasks will appear on your invoice the way they are typed into BarBooks, so make
sure you are case-Conscious.

Security — 2-Step Authentication

Profile Rates Task Description

2-Step Authentication




2-Step Authentication is a security feature designed to help protect your BarBooks account in addition to
your password. If you activate 2-Step Authentication, you will be asked to enter your password and an
authentication code generated by an Authenticator app on your phone.

Installing an Authenticator app

If you already use an Authenticator app, add your BarBooks login to it.

If you do not already have one, we recommend one of the following, which are all free to download from
your phone’s app store.

e Google Authenticator

o IOS: https://apps.apple.com/au/app/google-authenticator/id388497605

o Android:

https://play.google.com/store/apps/details?id=com.google.android.apps.authenticator?

e Microsoft Authenticator

o I0S: https://apps.apple.com/au/app/microsoft-authenticator/id983156458

o Android: https://play.google.com/store/apps/details?id=com.azure.authenticator
o Twilio Authy

o IOS: https://apps.apple.com/au/app/twilio-authy/id494168017

o Android: https://play.google.com/store/apps/details?id=com.authy.authy

Setting up 2-Step Authentication

If you have not already done so, install an Authenticator app.

From within Preferences, click the Security tab.

Turn on 2-Step Authentication.

Scan the barcode showing in BarBooks using your Authenticator app.

Enter the authentication code generated by your Authenticator app into BarBooks, then click
Verify.

o~ wnd =

You are now set up to use 2-Step Authentication next time you log into BarBooks.

Disable 2-Step Authentication

1. From within Preferences, click the Security tab.

2. Turn off 2-Step Authentication.

3. You will now receive an email informing you that your 2-Step Authentication is disabled. If you
didn’t action this, please contact us immediately.

Don’t have your phone with you when logging in?




If you do not have access to your phone for any reason, you can log in using a one-time authentication
code sent to your email.

1. When logging in, click on on “Don’t have your phone with you?”
2. A one-time authentication code is sent to your email, enter the authentication code into BarBooks

to login.

Switching to a new phone

If you already have 2-Step Authentication to protect your BarBooks account, and you have changed your
phone, you will need to disable 2-Step Authentication and set up 2-Step Authentication using your new
phone.

1. From within Preferences, click the Security tab.
2. Turn off 2-Step Authentication.
3. Enable and set up 2-Step Authentication again using your new phone.

Online Payment

Profile Rates Task Description Security Online Payment

Get paid quickly and easily

vPin Payments X 3&5 B

Step 1 - Sign-up via Pin Payments

1. Create your free account

https://pay.pinpayments.com/ rid7?

Step 3 - Update your invoice template

Add online payment as one of the payment methods and embed the

[Profile: Pin Payments} tag in your invoice template.

How to embed a hyperlink in a document.

1. Highlight the ou want to use as a link.
2. Goto Insert > Li nki;
3. Type the tag "{Profile: Pin Payments}" into the Address field.

4. Click OKtoc

right click the text and select Link

te your hyperlink.

fyou need further assistance, please contact customer support via our website

.barbooks.co.



How to set up your Pin Payments account

ok~

From within Preferences, click the Online Payment tab.
You may create your free account in this link - https://pinpayments.com/get-started/barbooks

in your BarBooks account
6. Go to this link for more information on how to set up your Pin Payment account -
https://pinpayments.com/getting-started

Submit your application within your Pin Payments account by providing your business details
Go to Accounts, then click Payment Page
Copy the Pin Payments code from the Payment page link and Paste it to the Online Payment tab

0 Pin Paymonts Your Account

New Charge

52 Overview

LL Business details
fit Bank account
<> APlIKeys

[ Receipts

(=4 Matifications
Your details

[EZ] Personal details
& Password

Ea Two-step verification
Fayment tools

F51 Payment Pags

(] Payment Button
Point of Sale

&

S Webhooks

Integrations

r_\ Xero

Continue

Get Paid with a Payment Link
Send a fink to customers so they can easily pay you securely online. Learn more

Amount Currency

AUD -

Description

Success URL (optional)

Options
Live Payment @ Test Payment
® Amount is editable L Amount is fived
Live payments will be available once you aciivate your account

Surcharging

Add Custom Fields.

Payment Fage link: (] ony

hitps./ipay pinpayments. :c

Activate your account for live transactions



How to update your invoices

If you are using a customized template, download the current one from the Templates tab.
Click the Tags button and View Tags for Regular Invoice

On the list of Profile tags, Select Pin Payments to see the corresponding tag

On your template, embed a hyperlink by highlighting the text you want to use as a link

Go to Insert > Links > Link

Paste the Pin Payments tag into the Address field, then click OK to create your hyperlink
Save the template in your computer and upload it again to your BarBooks account under the
Templates tab

NOoO o M~Od

X Tags

View tags for

Tag

Pin Payments Support contact details

Should you have any questions or concerns on your Pin payments account, you may reach the Support
team here - https://pinpayments.com/contact

Setting Up CPD

298 days

subscription left

Avatar 4 - e
CPD (00750 points o d Add CPD F ‘n Filters Filter by title,
My Account R :
Preferences ‘ ‘:Ai‘ ’f:”ters - Alltime
—— Current Year ocsopoint

Logout 0of50point  Current Year v




Current Year

T [ r——T——y [ iito ]

Track your CPD units and seminars in Barbooks.

Click the Avatar and go to CPD.

Click the gear icon to update CPD settings.

Click the Filters button to change the view to All Time or Current Year.
Click the Add CPD button to add new CPD activity

Mown o~

4. QUICK TABS

Dashboard

R > -]

You can track and monitor your work in progress, payments and expenses over any time on the
BarBooks Dashboard.

1. Trend/Graphs — this represents the total amounts of unbilled tasks, billed tasks, receipts, and
invoiced for a given date. You can choose to view the amounts in inclusive or exclusive GST.

2. Overview — shows the list of tasks, expenses, receipts for a given period of time.

3. Tasks — shows the list of all tasks for a given period of time. It also shows the totals specific to a
matter or period.

4. Help & settings — using this button, you can choose what columns to include and in what order
they should appear.

5. Export Function — You may export the data in Overview and Tasks section by clicking the Export

to CSV button.

10



Matters

Creating a Matter

X
Desrriptisn [ ]
........ B agreement L
...........
Bried
.....
hdige
siatry
Name Firm dci
o +
sallhor +
................
..........
X v X v
Detail o Batec Eixed Fee Do you want to apply the changes to the selected tasks? You can also select specific tasks.
Mame & GST incl. GST Type +
Old Fees (incl. New Fees {incl.
hour $100.00 $110.00 hourly = X Description > Time/Units GST GST)
- | X [v]  sampleTask: 10:00:00 @

1. Go to Matters tab and click the Add Matter button.

2. Fill out the necessary information.

3. Choose a Firm and a Solicitor from the drop-down list or you may also add a Firm or a Solicitor
by clicking the Add button.

4. Go to Rates tab to for setting matter specific rates. If you set rates from within a matter these
rates will only be specific for that matter. You may also change these rates after creating a matter
if you wish, a pop up box will appear asking for a confirmation if you would like these rates to be
applied to the selected unbilled tasks.

5. For GST free matters, please deselect the GST box in the Matter Details tab before creating any
tasks.

11



Creating a Fixed Fee Matter

x v
Detail Rates o Fixed Fee
Amount (incl. GST)
Amount [GST) $0,00
1. Go to Matters tab and click the Add Matter button.
2. Click the Fixed Fee tab.
3. Enter the value you wish to bill the matter for its entirety.
4. If you would like to convert the fixed fee matter to a regular one, simply remove the amount in the

box or enter a zero amount. Also, please make sure there are no invoices generated in the matter.

Adding, Deleting, and Transferring Tasks in a Matter

Matters X
Sample new Description
« O Ergal I o
- Date Advising o
o o e ?e:j nfime:sjs
+  addtask [EENCER nﬂ Rate ; nERam
$ GST Appearance
E Discount Sample description
1. Open a particular matter and click the Add task button.
2. Enter the details of the task in the Description field. What you enter in the description will appear
on your invoice. Remember to be case-conscious.
3. If you have Task Descriptions saved in your Preferences, you may use them by selecting in the
dropdown list of the Description field.
4. To delete a task, just tick the checkbox next to the Description of the task and click the Delete

button.
To transfer a task to a different matter, select the task and click the Transfer button. Select the
Matter where you would like that task to be transferred to then click the Green Tick to proceed.

Please note that you cannot delete or transfer any billed tasks.

12



Adding Disbursements in a Matter

To add a disbursement, open the matter where you want to add a disbursement.
Click the Disbursements tab within the matter file.

Click the Add disbursement button.

Fill in the required information and click the Green Tick to save.

Mo~

Archiving and Unarchiving a Matter

' +  Addmatter E g | i z
BOE | oo s -
Active /
Hame )
o Name Firm Archived v

All time
:Z| Last 7 days

1. Select a matter by ticking the box next to its name.
2. To Archive, click the yellow Archive button.

3. To Unarchive, choose Archived from the drop-down list of the Filters box, then select the matter
you wish to unarchive and click the green Unarchive button.

Please note that you cannot archive a matter with outstanding invoices and unbilled tasks.
Deleting a Matter

og -
o Name Firm

1. Select a matter that you wish to delete by ticking the box next to its name.
2. Click the red Delete button.

13



Please note that BarBooks will not allow you to delete any matters with tasks, disbursements, invoices or

receipts saved in the matter.

Downloading Matter Documents

Matters

X

T

Blank Which document type would you like to download?

Cost Agreement
Variation of Fees

Statement of Qutstanding Fees

Click the Matter tab.
Open a particular matter file.

L o\ e I

Send the document to a client/solicitor.

Please note that documents will be populated with relevant information from your matter into the

templates you uploaded in Templates tab.

Generating a Statement of Qutstanding Fees

Matters

E Filters =
o MName Firm

Select a matter by ticking the box next to its name.
Click the purple Statement of Outstanding Fees button.

Hoon =

Click the Add New matter document button and choose a document from the list.
Select the document type. You may download your documents in PDF or Word format
Save the file to an easy-to-find location on your computer.

Select the document type. You may download your documents in PDF or Word format
Save the file to an easy-to-find location on your computer.

14



Exporting data in CSV file

Matters

4+  Add matter E Filters =

Export the tables you see on the Matters page to CSV by clicking the Export to CSV button. You may
also filter the data before exporting.

Invoices

Creating an Invoice

There are two ways to create an invoice.

A. From the Matters tab:

<]
o #

<

Y ;| @ °
o 7 °

o

+  Addewoxe [ -

» @ [+ o

Select the matter you wish to invoice by clicking on the matter name.

Go to the Invoices tab.

Click the Add invoice button.

Choose the type of invoice you would like to issue.

Choose from the unbilled tasks and disbursements, apply a discount if there’s any, and select a
template, then click the OK button.

6. Select the document type. You may download your documents in PDF or Word format

o~ wn =
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B. From the Invoice tab:

Invoices

\l| Filters~

Name = Unbilled Outstanding

Regular
Interest
X Q
=
1. Go to the Invoices tab.
2. Click the Add Invoice button.
3. Choose the type of invoice you would like to issue.
4. A pop up box will appear containing a list of matters with unbilled tasks. Select one then click the
OK button.
5. Choose from the unbilled tasks and disbursements, apply a discount if there’s any, and select a
template then click Ok button.
6. Select the document type. You may download your documents in PDF or Word format

Recording a Payment in The Invoices Tab

Invcices

Moo

'. g Filters =
MNumber e Matter

00100521

Click the Invoices tab.

Open the invoice by clicking the invoice number.

Click the Paid button.

Choose from the drop-down list the type of payment that you would like to apply. If it is a part
payment, enter the payment amount, enter the date then click the OK button.

16



5. You may download the receipt by selecting a template from the dropdown list then select the
document type.
6. You may also declare the payment method and add a note on the payment. (Optional)

Writing Off an Invoice in Invoices Tab.

Invoices

+ [ '-_-.j-| Filters -

Number o Matter

00100521

Click the Invoices tab.

Open the invoice by clicking the invoice number.

Click the Write-Off button.

Choose from the drop-down list the type of write off that you would like to apply. If its Part, enter
the amount, enter the date then click the OK button.

Hown -

Reversing the Write-Off of an Invoice

o Number Type Date Invoice | Mi
[v]

1. Click the Receipts tab.
2. Select the write-off receipt number you would like to reverse.
3. Click the Delete icon.

Downloading an Invoice

m L“atterq
ERCDE s R

Derek's Invoice
Issued =
19/12/201
Number e Matter :

00100521 Due 18/01/2018

With Outstanding Fees

filt

filt
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Click the Invoices tab.

Open the Invoice by clicking the invoice number.

Click the Download button and select from the list of available invoice templates.
Select the Document type. You may download the invoice in PDF or Word format
Download will start automatically.

ok~

Deleting an Invoice

Invoices

EEEE0nn -
e Number Matter

00100521

Click the Invoices tab.

Select an invoice you wish to delete by ticking the box next to the Invoice number.
Click the Delete button.

Once the invoice is deleted, all tasks contained will become unbilled.

oo

Please note that you can edit the invoice number, the issue and due dates by clicking on them. You
cannot delete a paid invoice.

Exporting Invoices in CSV file

Invoices

Export the tables you see on the Invoices page to CSV by clicking the Export to CSV button. You may
also filter the data before exporting.

Receipts

Creating Matter Receipts

Matter receipts are automatically created when an invoice has been marked paid.

An invoice can be marked paid through:

18



1.
2.

Manual Payment (within Invoices tab)
Bank Reconciliation

Creating General Receipts

Receipts

Filters~

General Receipt Method

Tax Refund

Hown -

...... wer ype Date

Date

§imcl, GST

5 el GST

| ]

In the Receipts tab, click the Add receipt button.
Select General Receipt from the drop-down list.
Fill-in all required information then click the OK button.

To reverse the receipt, just tick the checkbox next to the Receipt number to select and click the

Delete button. Same step applies when reversing Matter receipts.

Adding a Tax Refund

X
Receipts
Note

+ Add receipt Filters ~ Filter by receipt numbe i

General Receipt

Date

§ inell GST

§ el GST

5657

Tax Refund
...... wer Type Date
1. In the Receipts tab, click the Add receipt button.
2. Select Tax Refund from the drop-down list.
3. Fill-in all required information then click the OK button.

Exporting the list of Receipts in CSV

Receipts

General Receipt

Tax Refund

...... Jer Type Date

19



Export the tables you see on the Receipts page to CSV by clicking the Export to CSV button. You may
also filter the data before exporting.

Expenses

These are the expense types:

1. General Expense - an expense you wish to charge to your business. Common general expenses
are floor fees, stationery, etc.

2. Tax Payment - any tax your business paid.

3. Personal Expense - any expense that you wish to record but do not wish to be charged to your
business. E.g. a personal gym membership, a percentage of your phone bill.

4. Disbursement — an expense related to a matter. When a disbursement is created from within the
Matters tab, BarBooks automatically generates an expense record in the Expenses tab.

Adding an Expense

Expenses I i

Description
+  Add expense n Filters ~ |
General Expense e Gs? + Sexd.GsT

Categ

Tax Payment

Personal Expense

]
[ ]

1. Click the Expenses tab.
2. Click the Add expense button.
3. Choose the type of expense you wish to add.
a. General Expense
b. Tax Payment
c. Personal Expense
4. Once you have selected the type of expense, you may now add the expense details as required.
a. Payee and Category — you may choose from the drop-down list or search by entering the
keyword, but you may also create a new payee or category by typing the name in the box.
(Optional)

20



Duplicating an Expense

Expenses

+  Add expense u Filters ~
G Description Category

1. Select the expense you wish to duplicate by ticking the box.

2. Click the Duplicate expense button.
3. Fill-out all required information, then click the OK button.

Deleting an Expense

Expenses

@ag -

° Description Category

1. Tick the checkbox next to the expense description to select.

2. Click the Delete expense button.

Exporting the list of Expenses in CSV

m

+ Mdm n Filters » Filter by description, catego

Description Categor

Export the tables you see on the Expenses page to CSV by clicking the Export to CSV button. You may

also filter the data before exporting.

21



Reports

How to Generate a Report?

Reparts

eriod Type

Click the Reports tab. Previously created reports will be listed in the table below.

To review these, click the Download button

Select the document type. You may download your documents in PDF or Word format

To create a new report, click the Add report button then choose from the list of reports, filter by
type, period, account etc. you wish to report on and click the OK button to generate report.

1.
2.
3.
4.

Types of Reports

Aged Debtors Report - this report provides a detailed list of which firms/solicitors/clients owe your
practice money. This report will show all invoiced work for a given time period of your choice. It can be
shown by Matter or by Solicitor

X v

By Type Solicitor o

By Date Invoice issue date *

L]
B
[}

From

22



Bank Transaction Summary Report — this report shows the transactions found in your Bank
Reconciliation for a certain time period. You will be able to select the Institution and Bank Accounts.

X

From

L}

To

Institution

Bank
Accounts

Cashflow & Activity Statement - this financial report is concerned with the flow of cash in and out of the
business. Cash inflows include all the receipts and tax refund while cash outflows include all the
disbursements, expenses, and tax payments. This report will also show the amount of other activities
such as Un-invoiced Tasks, Issued Invoices and Write offs. All of which is shown based on the selected
date range.

il
=

From To 15/01/2020

GST Statement — this report is also known as the Business Activity Statement (BAS). This will show the
computation of your tax payment or tax refund. You can choose a financial year as well as the quarter
which you want to report.

X v
Financial

Year

Quarter Q3 (1/1/2020- 31/3/2020 e

Profit and Loss Report — this is a financial statement that summarises all income and expenses incurred
during a selected period of time.

x W

From 15/12/2019 B To 15/01/2020 &

Include General
Recelpts?

Transactions Summary Report — this report shows the list of income, expenses, capital expenditure,
personal expenditure, and tax transactions within the selected date range.

23



X v

[}

To

From 15/12/2019

Work In Progress — this report shows the list of Matters with Unbilled work.

Year End Tax Report — this report shows the total amount of Sales, Expenses (exclude the Personal
expenses), and Tax for the selected financial year.

X v

Financial 2020 -
Year

Contacts

How to Create a Contact?

.......

[

1. Click the Contacts tab and click the Add contact button.
2. Choose a contact type to create from the drop-down list.
3. Fill out the required information then click the OK button.

How to Delete a Contact?




1. Click the Contacts tab.

2. Tick the checkbox next the first name of the contact (to select from the Clients, Firms, Solicitors,
or Others tab).

3. Click the red Delete button.

How Do | Edit a Contact?

1. Click the Contacts tab.
2. Click on the contact you want to edit from the Clients, Firms, Solicitors, or Others tab.
3. Edit any contact details that you wish.

Please note that when you edit a Firm there will be a pop up message asking you to confirm if you want
to apply the changes to the solicitors linked to that Firm. You may also add a contact on the go, while
creating a matter.

Templates

Default Templates

BarBooks automatically supplies you with a number of templates that are fully compliant with regulations
set by the Bar Association. These templates can be edited to suit your style and need.

Cost Agreement

Interest Invoice

Invoice

Matter Receipt

Statement of Outstanding Fees
Variation of Fees

L o o e

Creating a New Template

el

Download | Upload
[ 4]+ ]
oa
oD
[ +]+]
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File No file chosen.

Name o [ |

Type |

Name ~ Type

With Qutstanding Fees Tivolce

1. Click the Templates tab and click the Add template button.

2. If you would like to add your own template, select Custom and upload a .docx template you have
previously created.

3. After adding your template, you can amend the name and the type of template.
(Choosing the type of template is important as it correlates to where the document can be used in
the system)

4. You may click the Upload button beside the template type if you would like to upload a different
file or the Download button to change or edit the previously uploaded file.

5. You may always update the name of the template by clicking the Template name.

Please note that if you create your template under the wrong type of file, BarBooks will not be able to
generate the desired document correctly. Please make sure to save the template in .docx file.

If you make a variation to your rates, be sure to create different templates for each and name them in
such a way that it will be easier for you to identify which template is to be used.

If you need assistance with re-creating a template, you can send a copy of the template and a sample
output to us at support@barbooksaustralia.com and we would be glad to help you with your template.

Editing Templates

Download | Upload
@pno
oo
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sl g T s

1. Click on the Templates tab.

2. Download the template you wish to edit by clicking the Download button beside the Template
type.

3. The document will be downloaded as a Word file (.docx).

4. Click the Tags button. A small window will open with all the tags available to pull in matter specific
information or your personal detail. In the window, you can set the type of template you wish to
find tags for to copy and insert directly into your template Word file. When you have found the
correct tag, copy and then paste it into the Word file.

5. After editing the Word file, save it in .docx file then upload it in your account by clicking the
Upload button beside the template.

How Do | Add a Digital Signature?

If you do not have a digital signature, we can help create one for you. Simply sign on a blank piece of
paper. It needs to be plain with no text on the back of the paper. Then, take a photo and email it to
support@barbooksaustralia.com.

Bank Reconciliation

You can subscribe to the BankRec service to connect BarBooks to your bank. Your transactions will flow
into BarBooks, ready for you to reconcile. Your bank transactions can be reconciled easily with coding
suggestions and you can also set up rules for matching your transactions automatically to invoices,
payments and purchases that are recorded in BarBooks, making reconciliation seamless.

Overview of Bank Accounts

Impart

, transactions
_-st.-:v. accounts Lastimportidate button

Shortcutibuttons

How to Import Transactions
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1. To import transactions, click the Import transactions text-link for each bank account.
2. The table also shows you when is the last import date or if it’s up to date.
3. If you hover your cursor on a bank account, you will see buttons appearing on the right side —
these are shortcut to the tabs within each bank account.
a. Reconciliation: Receive

b. Reconciliation: Spend
c. List of Transactions
d. Bank Rules

e. Deactivate

f.

Activate (not in the picture)

Adding a Bank Account

Please select your banking Institution I Please enter your ANZ login credentials
Customer Registration Number

Password

ANZS, IO ©seswsak —

BOQk ’ ING Wi

| = Back

nab *ngeurge SUNCORP

WiFestpac

Show All

1. Click the Add Bank Accounts button.
2. Select your banking institution.
3. Enter your log in credentials.

Please note that we do not, and will not, have access to your bank account login or password. You can
add as many bank accounts as you wish.

Transaction Details Tab

Bank of CAPTCHA

Transaction Account  # &5iiias

CReznslistion Receve WA Reeoncibation: Speed I Transacticns B 5ank fules

Deteripition Date Aot = Slabun o
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Description
Date
Amount

Status Unreconciled

Once you have added a bank account and successfully imported your transactions, you may view the
details of your bank transactions by:
1. Hover your mouse on the account, on the right side you will see the Transactions icon. Click the
icon to open.
2. On the Transactions tab, click the Details button next to the transaction you wish to view
OR
3. Click either of the Reconciliation: Receive/Spend tabs, click the Details button under the Ignore
button next to the transaction you wish to view.
4. The Transaction details window will pop-up, in here you have the option to add notes on the
transaction.

Reconciliation: Receive Tab

1. Click the Reconciliation: Receive tab within the selected Bank Account.
2. There are 3 ways you can reconcile a Bank Transaction to a BarBooks record — Match, Find,
Create.
a. Match — BarBooks automatically finds and suggests an existing invoice or receipt that is a
possible match to your bank transaction. The amount and date of the invoice or receipt
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should be the same as the bank transaction. The date should be same or earlier than the
bank transaction. To reconcile, click the green Match button located in between the
transactions.

b. Find —if there is already an invoice or receipt created in your account, you can search for
it here. Locate the invoice or receipt, then reconcile by clicking the Match button.

c. Create — by using this option, you can create new receipt records in BarBooks as you see
the bank transactions come into your bank account while you are reconciling. Choose
which type of receipt you wish to create: Matter Receipt, General Receipt, or Tax Refund.
You can check the Receipts tab for the all the receipts created from bank reconciliation.

Reconciliation: Spend Tab

]
]

541423

1. Click the Reconciliation: Spend tab within the selected Bank Account.
2. There are 3 ways you can reconcile a Bank Transaction to a BarBooks record — Match, Find,
Create.

a. Match — BarBooks automatically finds and suggests an existing expense record that is a
possible match to your bank transaction. The amount and date of the expense should be
the same with the bank transaction. To reconcile, click the green Match button located
between the transactions. Please note that when you hit match, the transactions will just
be reconciled and there will not be a duplicate entry.

b. Find —if there is already an expense created in your account, you can just search it here.
Locate and select an expense, then reconcile by clicking the Match button. If the expense
from BarBooks transaction is less than the bank transaction you may still add another
expense or just partly reconcile it. You may adjust the amount or edit the details of the
expense by clicking the pencil icon.
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c. Create — by using this option, you can create new expense records in BarBooks as you
see the bank transactions leave your bank account while you are reconciling. Just choose
the type of expense record you wish to create: General Expense, Tax Payment,
Disbursement, or Personal Expense. You can check the Expense tab for all expenses
created from reconciliation.

Transactions Tab

This tab lists all the bank transactions whether ignored, reconciled, or unreconciled.

ol

You may Ignore any transactions here. Select from the list by ticking the checkbox next to the
description, then click the Ignore button.

You may also Reinstate the ignored transactions by ticking the transaction and clicking the
Reinstate button.

You also have the option to Un-reconcile and reconciled transactions.

To see the details of the transaction, click the Details button. Within the Transaction details box,
you may click on Receipts, Invoices, Expenses links to see the additional details.

o] e [ [
[Com ]
[
» X
Descripti Money to Crownbet
T Description M
Date
Amount Date
Status Amount
Status
Receipts Notes
Receipt Imvoice
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Bank Rule

o
A ’ T o e e
for Transaction Account s456Te5 . 538 12145 or Transaction Account scoTes 558 13345
Rule name
Rube name |
Waven bari:
When bank i allof the fol

for Transaction Account s436785 . 558 12345

Type
Tree Description
Description -
Method Payee ©
GST inel. = Category
X

Rule name |

When bank transaction matches all of the following conditions:

Special characters will be ignored when matching rules

To create a Bank Rule, go to the Bank Rules tab.
Click the Add rule button.
Select from the dropdown list the type of rule.

Hown -

Fill-in all required information, then click the OK button to save.

Splitting Options

01-05-2020

- $394.08

© Bank Fules
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Date 01/05/2020 5 inel, GST 5334.08 Payee @

GST I v § excl, GST

Type Expense - 5 GST o e
x

1. To split a General Expense, go to the Reconciliation: Spend tab, select General Expense as the

type.

Click the Splitting option icon.

Click the add button to determine how many times the transaction should be spilit.

Fill-in all the required information, and make sure that there is no outstanding amount.

When setting the splitting options for Spend Money Rules, you may choose the type of splitting —

it may be by amount or percentage. If it’s percentage, it must total to 100%.

6. Splitting options can also be found when you are creating a Spend rule with General Expense as
the type.

o~ e

Deactivate and Activate Bank Accounts

You can deactivate a bank account that you no longer use, whenever you wish. Once you have
deactivated an account, you will not be able to open it, you must reactivated the account by clicking the
Activate button to open it or import transactions from it again.

Trouble Shooting

If you are unable to import the transactions please re-add the bank account by clicking the Add Bank
Accounts button, choose the banking institution, and enter the login credentials which is the same as
your online banking.

If it still doesn’t work, please contact us at support@barbooksaustralia.com and add a screenshot of the
error message if there’s any.

5. QUICK ACTION
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This is the quickest way to do your recurring tasks.

List of Timers

| What action do you want to take?

No description
o | A y

You can see the List of Timers by clicking the Quick action button then select List of Timers or you can
also hover your cursor over the timer at the top right of the screen (when there is an active timer running),
then click the List of Timers button.

Active Task

Active task

No description Manage ™

] Q Unbilled Work $35,125.00 Invoices $29,820.00 Q A

This will show you the task, which you can see also at the top right of the screen. You can manage the
task by editing, deleting, and opening the matter (if it is already linked in a matter).

Incomplete Task

Incomplete tasks

No description Manage = No description Manage™ No description

Manage >

This section will show you the list of tasks with partial details (tasks not yet linked in a matter).
Paused Tasks

This shows the list of tasks you started but not yet ended. If you click the stop button of a certain task, it
will then be removed in this list.

Create Task
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$Totalind, 65T 5000 §Totalencl 65T 50.00
&

START TIMER IMMEDIATELY siomest

This button will enable you to create a task even when you are not in the Matters tab. Select a matter,
then fill-in all the required information and click the OK button to save.

Start Timer Immediately

x

.......... |
Quick action v
Trate Touat [ ] Duratian
What action do you want to take? nate y -

LIST OF TIMERS

CREATE TASK

START TIMER IMMEDIATELY

Upon selecting this button, the timer will start even while you are entering the details. You can also enter
the details later and it will be in the Active Task section and will be found as an Incomplete task if a matter
is not yet linked to it. Please note that only active matters with hourly rate can be selected.

6. SUPPORT

BarBooks customer support team is knowledgeable and friendly. Our support team can help you with
product knowledge, provide tips, share tailored reports, and assist you with any questions. Please get in
touch with us.

e Email: support@barbooks.co

e Phone: +61 295 397 816 (Monday — Friday 10am — 6pm AEDT)

o Website: https://www.barbooksaustralia.com/contact/

e Live chat
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